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                        2. Цель и задачи учебной дисциплины
Содержание предмета направленно на формирование у студентов теоретических основ художественно-конструктивного оформления и макетирования. 

Цель: получение студентами знаний и практических навыков работы в прикладных графических программах CorelDraw и Adobe Photoshop, а также применение этих знаний для создания художественного образа в процессе роботы от авторского эскиза до оригинал макета, что является последним этапом в формировании художника компьютерной графики, необходимого для специальной подготовки и будущей профессиональной деятельности.


Задачи: формирование у студентов представления о роли художника, как коммуникатора в современном обществе;

· Освоение теоретичных основ создания цифровых изображений, освоение практических навыков роботы с определенным кругом прикладных графических программ;

· Освоение базовых знаний промышленных технологий, связанных с визуализацией;

· Формирование определенной технической культуры в художественной среде, развитие практических навыков анализа созданного проекта, выбора технологий, программных продуктов, способов, что обеспечат выполнение проекта в полном объеме;

· Формирование представления роли художника-коммуникатора в современном обществе.

В результате изучения учебной дисциплины студент обязан:

знать: 

· принципиальную разницу, взаимодействие и область применения двух типов компьютерной графики;

· состав растрового изображения;

· состав векторного изображения;

· типы цветовых моделей;

· интерфейсы, функциональные возможности и особенности прикладных графических программ;

· что такое выделение, маска, альфа-канал;

· режимы смешивания цветов;

· теоретические основы создания цифровых изображений;

· основы промышленных технологий, которые связаны с визуализацией изображений.

уметь: 

· анализировать задачи, которые требуют создания, художественной обработки или редактирования с помощью компьютера, принимать решения для выбора технологий и техники исполнения;

· пользоваться инструментами рисования векторных линий и примитивов;

· создать и редактировать графический документ;

· пользоваться инструментами выделения;

· пользоваться, создавать и изменять параметры кисти;

· реставрировать изображения при помощи инструментов восстановления;

· использовать векторные фигуры в растровом редакторе;

· работать с текстом в растровом редакторе Photoshop;

· выполнять задания при помощи компьютера, которые требуют создания или редактирования изображения в пределах специализации «Художественное оформление», «Скульптура»;

· самостоятельно оценивать программные продукты их особенности, которые связаны с направлением выбранной профессиональной деятельности.
3. Программа учебной дисциплины
2 курс 4 семестр

	Тема 1. Вступительная беседа Векторная и растровая графика.
Все изображения, с которыми работают программы машинной графики, разделяются на два класса; пиксельные и векторные.

В терминологии машинной графики пиксельным  изображением принято называть массив пикселей - одинаковых по размеру и форме плоских геометрических фигур, расположенных в узлах регулярной сетки. Для каждого пикселя задается цвет, цвета кодируются числами фиксированной разрядности. Представление пиксельного изображения в памяти компьютера - это массив сведений о цвете всех пикселей.

Векторным изображением в компьютерной графике принято называть совокупность более сложных и разнообразных геометрических объектов. Номенклатура таких объектов может быть более или менее широкой, но, как правило, в нее включаются простейшие геометрические фигуры (круги, эллипсы, прямоугольники, многоугольники, отрезки прямых и дуги кривых линий). Важнейшая особенность векторной графики состоит в том, что для каждого объекта (или, как мы будем более точно говорить далее, класса геометрических объектов) определяются управляющие параметры, конкретизирующие его внешний вид. Например, для окружности такими управляющими параметрами являются диаметр, цвет, тип и толщина линии, а также цвет внутренней области
Задача: дать представление о различных типах графических файлов.
Задание: Понятие о существующих графических моделях  в цифровых файлах, их различие и предпочтения.
По теме выполняется самостоятельная работа. 



	Тема 2. Настройка рабочего пространства CorelDraw.
В левой части рабочего пространства расположен специфический для продуктов фирмы Corel элемент интерфейса — так называемый набор инструментов (toolbox). 

В расположенной под строкой меню стандартной панели инструментов (toolbar) расположены элементы управления, соответствующие наиболее часто выполняемым командам: открытию, сохранению и закрытию файлов иллюстраций, операциям с системным буфером обмена, режимам и масштабу просмотра иллюстраций.

Ниже стандартной панели инструментов по умолчанию располагается панель атрибутов (property bar).

Вдоль правой границы окна расположена экранная палитра цветов (color palette).  Она применяется для задания цвета заливки и обводки объектов иллюстрации.

Основная часть рабочего пространства CorelDRAW отведена для размещения окон документов (drawing windows) CorelDRAW.

Задача: Ознакомиться с рабочим пространством редактора CorelDraw. Научиться настраивать рабочее пространство под различные запросы пользователя.
Задание: Научиться настраивать рабочее пространство под различные запросы пользователя.
По теме выполняется самостоятельная работа. 

	Тема 3. Панель инструментов.
Ознакомление с панелью инструментов и свойствами инструментов, при помощи которых создаются новые и редактируются существующие векторные изображения.
Набор инструментов (toolbox). Формально являясь просто одной из множества инструментальных панелей программы, фактически он предназначен выбора рабочего режима и поэтому используется чаще других. Выбор режима осуществляется щелчком мышью на одной из кнопок набора инструментов. С выбора инструментов начинаются практически все действия пользователя над объектами изображения.

Некоторые кнопки инструментов снабжены треугольником в нижнем правом углу. Это - указание, что на самом деле с кнопкой связан не один, а несколько инструментов. Чтобы увидеть их все, вместо быстрого щелчка левой кнопкой мыши ее следует нажать (отпустив только после паузы в одну-две секунды) — на экране раскроется панель конкретного инструмента. 

Панель атрибутов (property bar). Она представляет собой совокупность элементов управления, соответствующих управляющим параметрам выделенного объекта и стандартным операциям, которые можно выполнить над ним с помощью выбранного инструмента. Содержимое панели атрибутов постоянно меняется.
Задача: Изучить панель инструментов и связанную  с ней панель свойств инструментов.
Задание: Изучить связь инструмента с панели инструментов с панелью свойств инструментов. Уметь настроить панель свойств инструментов

	Тема 4. Создание и модификация объектов.
Основой работы с изображением в CorelDRAW являются объекты. Несколько упрощая, можно констатировать следующее: все графические объекты, с которыми приходится иметь дело пользова​телю этой программы, можно разбить на две категории — линии и примитивы.

Форма линий произвольна и не связана никакими ограни​чениями, кроме творческого замысла художника. Сказать «построим линию» означает не сказать почти ничего, и никаких четких зрительных образов за понятием «линия» не стоит. Однако если сказать, что четыре попарно равных отрезка прямых линий, соединяясь в конечных точках, образуют при этом четыре прямых угла, то в сознании всплывает не только четкий зрительный образ, но и термин для обозначения подобных объектов - «прямоугольник». Конечно, нельзя по​строить просто прямоугольник, без дополнительного уточнения не обойтись, но отличия прямоугольников от других графических объектов достаточно очевидны и позволяют выделить их в отдельный класс объектов. Чтобы выделить конкретный объект этого класса, достаточно задать значения его атрибутов, например высоту и ширину.

В CorelDRAW имеется несколько классов таких четко определяемых графических  объектов под обобщающим названием примитивы.
К  примитивам относятся - прямоугольники, эллипсы, многоугольники, звезды, спирали, сетки (стандартные фигуры, у которых есть свои атрибуты).
Модификация графических объектов - изменение размеров, деформация, перемещение производится при помощи манипулятора «мышь», при нажатии горячих клавиш «Ctrl» и «Shift» можно получить различные виды модификации объектов.
Задача: научиться создавать и модифицировать объекты Corel Draw.
Задание: Создание примитивов и модификация  их при помощи «горячих» клавиш и манипулятора «мышь».
По теме выполняется самостоятельная работа. 



	Тема 5. Создание и редактирование контуров.
Модель кривой.

В основе принятой в CorelDRAW модели линий лежат два понятия: узел и сегмент.
Узлом называется точка на плоскости изображения, фиксирующая положение одного из концов сегмента кривой. Сегментом называется часть кривой, соединяющая два смежных узла. Узлы и сегменты неразрывно связаны друг с другом.

Любая кривая в CorelDRAW состоит из узлов и сегментов, и все операции с кривыми на самом деле представляют собой операции именно с ними. Узел полностью определяет характер предшествующего ему сегмента, поэтому для незамкнутой линии важно знать, который из двух ее крайних узлов является начальным, а для замкнутой — направление линии (по часовой стрелке или против нее). По характеру предшествующих сегментов выделяют три типа узлов: начальный узел незамкнутой кривой, а также прямолинейный (line) и криволинейный (curve) узлы.
Для узлов, смежных хотя бы с одним криволинейным сегментом, имеется еще одна классификация типов: они подразделяются на точки излома (cusp) и сглаженные узлы (smooth). 
Узел называется точкой излома в том случае, когда касательные, проведенные в узле к двум прилегающим к нему сегментам, не лежат на одной прямой, образуя угол, отличный от развернутого. 

Узел называется сглаженным, если касательные, проведенные к двум прилегающим к нему сегментам, лежат на одной прямой.

Создаются линии (кривые) при помощи инструментов: Freehand (Свободная форма), Polyline (Ломаная линия, 3-Point Curve (Кривая через 3 точки, Bézier (Кривая Безье), Pen (Перо), Artistic media (Художественное оформление).
Задача: Освоить создание и редактирование контуров.
Задание: Задание по обрисовке растрового изображения.
По теме выполняется самостоятельная работа. 

	Тема 6. Организация объектов.
Выравнивание объектов.

Выравниванием называется размещение всех выделенных объектов таким образом, чтобы их определенные точки (например, середины рамки выделения) располагались на одной прямой.

В CorelDRAW предусмотрен мощный инструмент, автоматизирующий выстраивание объектов в ряд вдоль прямой, положение которой задается одним из выравниваемых объектов или страницей документа.

Команда Arrange > Align and Distribute (Монтаж > Выровнять и распределить) и кнопка Align (Выровнять) панели атрибутов раскрывают на экране диалоговое окно, с помощью первой вкладки которого можно автоматически выровнять середины или края рамок выделения выделенных объектов по горизонтали и/или вертикали.

Распределение объектов.

Распределением объектов в CorelDRAW называется размещение объектов, при котором соблюдается равенство расстояний между маркерами их рамок выделения. Добиться этого размещением объектов вручную практически невозможно. Значительно удобнее решать такую задачу с помощью вкладки Distribute (Распределить) диалогового окна Align and Distribute (Выровнять и распределить).

Равномерность при распределении объектов может достигаться двумя принципиально различными способами: равными могут быть расстояния между одноименными маркерами рамок выделения  или интервалы, разделяющие объекты. При размещении объектов с разными габаритными размерами результаты размещения этими двумя способами могут сильно различаться. 

Задача: научиться выравнивать и распределять объекты относительно друг друга, страницы, рабочего пространства.
Задание:  Выбрать три различных по геометрии и объему объекта и распределить относительно рабочей страницы.
По теме выполняется самостоятельная работа. 



	Тема 7. Инструмент «Текст». 
Необходимость введения в инструментарий художника-оформителя, дизайнера, художника по рекламе средств автоматизации работы с текстом не вызывает сомнений. Более того, эволюция программ для работы с графическими изображениями привела к тому, что встроенные в них средства для работы с текстовой информацией по своим возможностям вплотную приблизились к аналогичным средствам не только текстовых процессоров, но и более развитых в этом аспекте редакционно-издательских систем. 

CorelDRAW имеется не один, а два класса текстовых объектов, во многом схожих, но в то же время четко различимых - как по своей структуре, так и по поведению. 

Фигурный текст

В общем случае фигурный текст представляет собой многоуровневый соединенный объект. Если такой объект выделить, а затем выбрать команду Arrange > Break Apart (Монтаж > Разъединить), после первого разъединения он превращается в совокупность фигурных текстов, каждый из которых соответствует строке исходного фигурного текста. Разъединение строки дает совокупность слов, и только разъединение слова дает совокупность фигурных текстов, каждый из которых будет «элементарным» — разъединить его не удастся, поскольку он состоит из одной младшей структурной единицы текста, символа.

Чтобы начать ввод блока фигурного текста, достаточно щелкнуть мышью в той точке страницы, где должен разместиться текст. При необходимости перехода на новую строку следует нажать клавишу Enter.

Простой текст

Так же как фигурный, простой текст представляет собой многоуровневый соединенный объект, но уровней, которые простой текст проходит при разъединении, больше, чем у фигурного текста. При разъединении большого объема простого текста могут получаться следующие структурные единицы: колонки текста, пункты перечисления, абзацы, строки, слова, символы. Кроме того, в отличие от фигурного текста простой текст не может располагаться непосредственно на печатной странице. В CorelDRAW любой простой текст располагается внутри особого объекта — рамки простом текста (paragraph text frame). При помощи связен рамки могут образовать составной объект — цепочку рамок простого текста, отдельные элементы которой могут размещаться даже на различных страницах документа CorelDRAW. Базовая форма рамки простого текста — прямоугольник, но в процессе последующих преобразований эти прямоугольники могут принимать произвольные формы

Простой текст создается при помощи того же инструмента, что фигурный, а именно — инструмента Text (Текст). Правда, создание простого текста предполагает еще одно предварительное действие — создание рамки простого текста. Поэтому после выбора инструмента Text (Текст) в наборе инструментов следует переместить указатель мыши в точку, где предполагается разместить один из углов будущей рамки, и перетащить его по ее диагонали. После отпускания кнопки мыши па экране появится изображение рамки выбранных габаритов, внутри которой расположится текстовый курсор в виде вертикальной черты. Можно приступать к вводу текста с клавиатуры.

При вводе простого текста поведение CorelDRAW иное, чем при вводе фигурного текста. Во-первых, переход на новую строку определяется уже не пользователем, а автоматически, по мере достижения текстом правой границы рамки, причем нажатие клавиши Enter означает переход не к следующей строке, а к следующему абзацу, который является более крупной структурной единицей текста, чем строка. Во-вторых, когда вводимый текст достигнет нижней границы рамки, текстовый курсор пропадает и вновь вводимого текста больше не видно. Из этого не следует, что текст не вводится — он лишь не отображается в пределах рамки.

Создание цепочки связанных рамок.

Цепочками связанных рамок простого текста пользуются для того, чтобы разместить одни текстовый фрагмент в нескольких местах одной страницы или на разных страницах документа. Речь идет не о размещении копий, а о продолжении текста при переходе из одной рамки в другую.

Задача: Научиться пользоваться инструментом текст.

Задание: Создать портрет знакомого персонажа из текста.
По теме выполняется самостоятельная работа. 

	Тема 8. Заливка объектов и контуров.

Однородные заливки.

Однородной заливкой называется заполнение ограниченного замкнутой кривой объекта цветом, который не меняется в пределах объекта. Чтобы назначить выделенному объекту или нескольким объектам однородную заливку с помощью палитры, достаточно щелкнуть на образце нужного цвета мышью. 

Специальные заливки.

Программа CorelDRAW изначально предназначалась для работы с иллюстративной графикой. В природе и окружающей человека среде практически не встречаются объекты с идеально однородными цветовыми поверхностями, и попытки разбить их изображения на однородно закрашенные части приводит к неестественности, «мультяшности». 

Градиентные и сетчатые заливки.

В категорию градиентных и сетчатых заливок сведены два класса заливок, обладающих общим признаком: в пределах заливаемого объекта выделяются некие «опорные пункты», для которых фиксируется цвет заливки, а в промежутках между ними цвет «перетекает», плавно меняясь. В полиграфии такие заливки называют цветовыми растяжками. В градиентных заливках в роли «опорных пунктов» выступают точки, прямые, квадраты и окружности, расположенные четко определенным образом (зависящим от типа градиентной заливки).

Сетчатые заливки.

Чтобы построить аналогичную сетчатой заливку другими средствами, потребовалось бы создавать множество отдельных объектов и градиентных заливок, а потом долго и кропотливо подгонять их друг к другу, добиваясь эффекта, с применением сетчатой заливки возникающего автоматически.

При назначении сетчатой заливки объекту произвольной формы на него накладывается сетка, имеющая заранее заданное число «строк» и «столбцов». Сетка состоит из узлов, соединенных линиями. 

Задача: научиться заливать объекты и контура цветом.
Задание: Знать особенности заливки цветом контуров, объектов, градиентную заливку и заливку сетки.
По теме выполняется самостоятельная работа. 

	Тема 9. Комбинирование объектов.
Операции группировки и соединения обратимы, и полученные в результате них образования можно снова превратить в отдельные объекты. Кроме того, в CorelDRAW есть группа необратимых операций, которые связывают исходные объекты сильнее, превращая их в единый объект: объединение, пересечение и исключение. Полученные в результате этих операций объекты уже нельзя преобразовать в исходные.

Группирование и разгруппирование.

Группированием называется операция, соединяющая совокупность отдельных объектов или ранее созданных групп в группу. Связывание объектов в группу позволяет обращаться с ними как с единым целым, выполняя преобразования группы как преобразование единого объекта.

Соединение и разъединение

Кнопка Combine (Соединить), предназначенная для выполнения этой команды, становится доступной на панели атрибутов после выделения не менее чем двух отдельных объектов. Побочным эффектом действия команды соединения является преобразование всех выделенных объектов в совокупности кривых (которые и становятся ветвями соединенной линии).

Для разъединения соединенной кривой на составляющие ее ветви используется кнопка Break Apart (Разъединить) панели атрибутов. После разъединения каждая ветвь приобретает статус отдельного объекта.

Объединение.
Операция объединения представляет собой удаление пересекающихся частей объединяемых объектов и составление из фрагментов их границ новой границы по линии общего абриса. Участвовать в операции могут два одиночных объекта, одиночный объект и совокупность объектов или две совокупности объектов.

Пересечение.

Операция пересечения создает новый объект из области пересечения двух или более объектов, участвующих в операции. Новый объект наследует атрибуты заливки и обводки «родительского» объекта.

Исключение.

Исключением объектов называется операция, при которой у указанного объекта удаляются части, перекрываемые выделенным объектом. 

Как обычно, в совокупностях и выделенных, и указанных объектов может быть несколько объектов. Если перед выполнением исключения выделено несколько объектов, то «форма для высечки» составляется как результат объединения этих объектов.

В состав совокупности указанных объектов могут входить не только индивидуальные объекты, но и их группы.

Задача: научиться создавать сложные объекты из примитивов.
Задание: Создать сложный (комбинированный) объект из примитивов используя инструменты комбинирования
По теме выполняется самостоятельная работа. 

	Тема 10. Спецэффекты.
Основное назначение CorelDRAW — создание иллюстративной графики, большинство произведений которой носят плоскостной, подчеркнуто графический характер. Поэтому передавать глубину и объем изображаемой сцены с учетом освещения и направления взгляда приходится чисто графическими приемами, имитируя блики и тени дополнительными объектами, а перспективу — искажением контурных линий объектов.

В CorelDRAW имеются средства для автоматического построения эффектов, имитирующих объемность и глубину сцены. В первую очередь к ним относится преобразование перспективы.

Для построения теней, отбрасываемых предметами на плоскость, можно воспользоваться приемом объединения группы объектов, изображающих фигуру, с последующим изменением заливки и формы полученного объекта, но можно воспользоваться и специальным инструментом для построения падающих теней.

Эффект экструзии позволяет построить на рисунке проекцию обобщенного цилиндра - тела, образующегося при перемещении плоской фигуры в пространстве в направлении, перпендикулярном ее плоскости. CorelDRAW автоматически выполняет параллельное или перспективное проецирование фигуры и строит как изображения боковых поверхностен обобщенного цилиндра, так и светотеневую картину на них.

Пошаговый переход позволяет быстро построить последовательность переходных форм между двумя управляющими объектами, разместить их вдоль заданной траектории, а затем менять внешний вид всех объектов одновременно, редактируя управляющие объекты перехода.

Контуры подобия, представляют собой вариант пошагового перехода с одним управляющим объектом. Семейство подчиненных объектов контура строится как последовательность фигур, близких геометрически к управляющему объекту.

Изобразительные возможности клонов, пошаговых переходов и ореолов практически безграничны, и сообщество художников, работающих с CorelDRAW, постоянно изобретает новые способы их применения.

Задача: научиться пользоваться инструментами по созданию эффектов в векторной графике.
Задание: При помощи инструмента перетекание, преобразование создать из простых фигур ритмичную открытую композицию 

По теме выполняется самостоятельная работа. 



	Тема 11. Экспорт растровых изображений. Печать.

Всего лишь несколько лет назад в 99 случаях из 100 процесс работы над графическим проектом завершался, выводом построенных с помощью CorelDRAW изображений на печать или передачей файлов в бюро полиграфического обслуживания. Неудивительно, что от версии к версии средства CorelDRAW, обеспечивающие подготовку к выводу на печать и саму эту процедуру, постоянно совершенствовались. Сегодня все больше графических работ публикуется в Интернете, и он уже перехватил у полиграфической промышленности пальму первенства в этой области. Отмечайся бурный рост и других технологий электронной. Поэтому сегодня результаты труда компьютерного художника материализуются в одном из трех вариантов: 

- в виде отпечатков, выполненных на монохромных или цветных принтерах, установленных в художественной студии или офисе, где работает художник; 

- в виде файлов с изображениями в различных форматах, предназначеных для интеграции в состав web-страниц, публикации другими электронными средствами или размещения на ftp-серверах в первом случаев качестве дополнения к графическому изображению может разрабатываться так называемая карта - описание активных участков изображения, используемых в качестве ссылок;

- в виде файлов с векторными и точечными изображениями в формате PostScript предназначенных для передачи в бюро полиграфического обслуживания в котором эти файлы выводятся на пленку специальными устройствами.

Экспорт рисунка в файл.

По умолчанию при сохранении рисунка с помощью команды File > Save As (Файл > Сохранить как) создается файл векторного формата CDR — собственного формата программы CorelDRAW. Экспорт рисунка в другой векторный формат можно выполнить с помощью стандартного диалогового окна Save As (Сохранить как), выбрав соответствующую желаемому формату альтернативу в списке Files of type (Тип файла). Однако более универсальным способом экспорта оказывается команда File > Export (Файл > Экспорт), дающая возможность сохранять проект как в векторных, так и в точечных форматах.
Задание: Экспортировать изображение созданное в CorelDRAW, для печати в типографии.
По теме выполняется самостоятельная работа. 




4. Структура учебной дисциплины
	Названия разделов и тем


	Количество часов

	
	дневная форма
	заочная форма

	
	аудиторных
	
	аудиторных
	Самостоятельная работа

	
	всего
	в том числе
	Самостоятельная работа
	всего
	в том числе
	

	
	
	групповые
	практические
	индивидуальне
	
	
	групповые
	практические
	индивидуальне
	

	Тема 1. Вступительная беседа Векторная и растровая графика.
	4
	 
	1
	 
	3
	
	
	
	
	

	Тема 2. Настройка рабочего пространства CorelDraw
	7
	 
	2
	 
	5
	
	
	
	
	

	Тема 3. Панель инструментов.
	7
	 
	2
	 
	5
	
	
	
	
	

	Тема 4. Создание и модификация объектов.
	4
	 
	1
	 
	3
	
	
	
	
	

	Тема 5. Создание и редактирование контуров. Итоговое задание.
	9
	 
	4
	 
	5
	
	
	
	
	

	Тема 6. Организация объектов.
	7
	 
	2
	 
	5
	
	
	
	
	

	Тема 7. Текст.

Итоговое задание.
	9
	 
	4
	 
	5
	
	
	
	
	

	Тема 8. Заливка объектов и контуров.
	4
	 
	1
	 
	3
	
	
	
	
	

	Тема 9. Комбинирование объектов.
	5
	 
	2
	 
	3
	
	
	
	
	

	Тема 10. Спецэффекты.
	3
	 
	1
	 
	2
	
	
	
	
	

	Тема 11. Экспорт растровых изображений. Печать.
	4
	 
	1
	 
	3
	
	
	
	
	

	Всего часов:
	63
	 
	21
	 
	42
	
	
	
	
	


5. Темы практических занятий
	№

п/н
	Название тем
	Количество часов

	1
	Тема 1. Вступительная беседа Векторная и растровая графика.
	1

	2
	Тема 2. Настройка рабочего пространства CorelDraw
	2

	3
	Тема 3. Панель инструментов.
	2

	4
	Тема 4. Создание и модификация объектов.
	1

	5
	Тема 5. Создание и редактирование контуров. 
	4

	6
	Тема 6. Организация объектов.
	2

	7
	Тема 7. Текст.

Итоговое задание.
	4

	8
	Тема 8. Заливка объектов и контуров.
	1

	9
	Тема 9. Комбинирование объектов.
	2

	10
	Тема 10. Спецэффекты.
	1

	11
	Тема 11. Экспорт растровых изображений. Печать. Итоговое занятие.
	1

	
	Всего часов
	21


6. Самостоятельная работа

	№

п/н
	Название тем
	Количество часов

	1
	Тема 1. Вступительная беседа Векторная и растровая графика.
	3

	2
	Тема 2. Настройка рабочего пространства CorelDraw
	5

	3
	Тема 3. Панель инструментов.
	5

	4
	Тема 4. Создание и модификация объектов.
	3

	5
	Тема 5. Создание и редактирование контуров. Итоговое задание.
	5

	6
	Тема 6. Организация объектов.
	5

	7
	Тема 7. Текст.

Итоговое задание.
	5

	8
	Тема 8. Заливка объектов и контуров.
	3

	9
	Тема 9. Комбинирование объектов.
	3

	10
	Тема 10. Спецэффекты.
	2

	11
	Тема 11. Импорт растровых изображений. Печать. Итоговое занятие.
	3

	
	Всего часов
	42


7. Методы обучения
    Вербальные, демонстрация образцов, практические.
Методические рекомендации

Теоретический материал преподается на лекциях, согласно запланированных тем и отведенных часов занятий. Тематика  занятий направлена на развитие эстетического вкуса и формирование художественной грамотности студентов, освоение программ по компьютерной графике и применение на практике знаний полученных в процессе изучения предмета «Компьютерная графика».

Методические рекомендации состоят из методических указаний по проведению самостоятельной работы студентов.

Цель практических и самостоятельных задач - ознакомиться и накопить опыт и технические навыки, необходимые в процессе обучения студентов.

При обучении важно приобретение ими теоретических знаний и практических навыков, которые положительно влияют на формирование профессиональных качеств высокой художественной культуры. Самостоятельные задания дают возможность выявить уровень и качество изучения студентом всего материала по предмету.

Для  планомерного  профессионального  овладения  предметом  важно, чтобы  студенты  постепенно  и  сознательно  выполняли  учебные  задания,  в  порядке:  от  простого -  к  сложному.  

Работа  преподавателя  со  студентами  должна  быть  последовательной  и  принципиальной.  Одними  из  важнейших  принципов  изложения  дидактического  материала  являются  заинтересованность  и  ответственность,  которые  передаются  от  преподавателя  -  к  студентам,  открывая  для  них  перспективы   дальнейшего  профессионального  роста  и  совершенствования,   стимулируют  к  поиску  оригинальных,  авторских  решений.
8. Методы контроля
    Практический контроль
В конце  4 семестра – итогова
9. Ориентировочное задание к итоговому контролю:

Разработка рекламно-графического комплекса (композиция): логотип, эмблема, визитка, конверт, оформление диска, плакат.

10. Методическое обеспечение

Учебно-методический комплекс по предмету «Компьютерная графика».

Образцы с метод фонда. Научная литература.

11. Рекомендованная литература
1. Adobe Photoshop CS4. Официальный учебный курс (+ CD-ROM)/ — Санкт-Петербург, Эксмо, 2009 г.- 464 с.

2. Adobe Photoshop CS5. Официальный учебный курс (+ CD-ROM)/ — Москва, Эксмо, 2011 г.- 432 с.

3. Баяковский Ю.М., Галактионов В.А., Михайлова Т.Н. Графор. Графическое расширение фортрана./ - М.: Наука, 1985. - 288 с.

4. Гевенян В. Adobe Photoshop CS: Волшебные фильтры и спецэффекты (+ CD-ROM) / — Санкт-Петербург, БХВ-Петербург, 2004 г.- 544 с.

5. Глушаков С. В. Adobe Photoshop CS3. Самоучитель/— Москва, АСТ, АСТ Москва, ВКТ, 2008 г.- 480 с.

6. Глушаков С. В., Гончарова А. В. Adobe Photoshop CS3. Самоучитель/— Санкт-Петербург, АСТ, АСТ Москва, 2008 г.- 480 с.
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